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Microsoft publisher 2010 tutorial

It is never too late to start learning and it would be a shame to miss an opportunity to learn a tutorial or course that can be as useful as Introduction to Publisher 2010 Tutorial especially when it's free! You don't have to register for expensive classes and travel from one part of the city to another to take
classes. All you need to do is download the course and open the PDF file. This specific program is classified in the Office category where you can find other similar courses. Thanks to the people (like you?) Sharing their knowledge, you can discover the degree of being selected to learn easily without
spending a fortune! Introduction to Publisher 2010 Tutorial. is available free of charge by its author. But also many other tutorials are accessible just as easily! Computer PDF guides you and allows you to save on your studies. Introduction to Publisher 2010 Tutorial. help on the contact form where
Computer PDF issues is also training courses in Word, Excel, PowerPoint, Writer, Calc, Microsoft Office, LibreOffice and more IT. You should come and see our Office documents. You'll find your happiness without any problems! The latest news and especially the best tutorials on your favorite topics,
that's why Computer PDF is number 1 for courses and tutorials for downloading in pdf files - Introduction to Publisher 2010 Tutorial. and Office! Download other tutorials for tips on Getting started with Publisher 2010 Tutorial. you'll see! We'll do everything to help you! And dear surfers what do you need?
Best course and tutorial and learn and use Introduction in Publisher 2010 Tutorial. Certainly! It is never too late to start learning and it would be a shame to miss an opportunity to learn a tutorial or course that can be as useful as Introduction to Publisher 2010 Tutorial especially when it's free! You don't
have to register for expensive classes and travel from one part of the city to another to take classes. All you need to do is download the course and open the PDF file. This specific program is classified in the Office category where you can find other similar courses. Thanks to the people (like you?)
Sharing their knowledge, you can discover the degree of being selected to learn easily without spending a fortune! Introduction to Publisher 2010 Tutorial. is available free of charge by its author. But also many other tutorials are accessible just as easily! Computer PDF guides you and allows you to save
on your studies. Introduction to Publisher 2010 Tutorial. help on the contact form where Computer PDF issues is also training courses in Word, PowerPoint, writer, iron, Microsoft Office, LibreOffice, and more IT. You should come and see our Office documents. You'll find your happiness without any
problems! The latest news and especially the best tutorials on your favorite topics, which is why Computer PDF is the number 1 for and tutorials for download in pdf files - Introduction to Publisher 2010 Tutorial. and Office! Download other tutorials for tips on Getting started with Publisher 2010 Tutorial.
you'll see! We'll do everything to help you! And dear surfers what do you need? Best course and tutorial and learn and use Introduction in Publisher 2010 Tutorial. Certainly! Microsoft Publisher 2010 is a program designed to help you create publications or documents that you can print and distribute. In
this lesson, you'll learn about the pros and cons of using Publisher 2010. You'll also learn about the Publisher interface, including ribbon, rulers and guides, and Backstage view. Familiarity with Publisher 2010 Even if you've never used Publisher before, you'll probably find its interface familiar because it
has many of the same features as other Microsoft Office programs. However, it includes some features specifically designed for creating publications. If you've used Publisher, you'll recognize these features, but you'll also notice some slight changes to the 2010 version. Publisher offers templates and
other tools to help you create a variety of publications, including brochures, newsletters, business cards, and menus. Examples of Publisher 2010 Publications After you may know, you can do most, if not all, tasks of the above mentioned tasks in Microsoft Word. So why not create publications using this
program instead? One of publisher's advantages is that it gives more control over certain aspects of the publication. For example, Publisher provides a work environment that makes it easy to work with documents in a variety of sizes and shapes. It also has a wider variety of tools to help you arrange and
align text, images, and other objects at the edges of the page. Publisher However, while Publisher has certain advantages, it also has the disadvantage of being the least developed program in the Office 2010 suite. It doesn't include theme colors, advanced image editing tools, or many of the other new
features featured in Word and PowerPoint 2010. In fact, for these features Publisher 2010 is more similar to Publisher 2007 and 2003 than with other current programs in the Office suite. As you start using Publisher 2010, you may find that you prefer to create certain types of publications in Word.
Learning Publisher While this course is an introduction to Publisher, it is not intended for those who are not familiar with word processing. To learn how to use Publisher with our course, you already need to know how to use Microsoft Word. If you don't already comfortable using Word, review the Word
2010 tutorial. Introduction to Publisher 2010 If you're familiar with Publisher 2007 or 2003, you'll notice some changes to the 2010 interface. The main change is the addition of ribbon, ribbon, appears in all Office 2010 programs. Publisher also added the Backstage view, which we'll cover later in this
lesson. In most other ways, the Publisher environment is pretty much the same as in previous editions. If you're new to Publisher, you should take some time to familiarize yourself with its interface. Review the interactive to learn more about the Ribbon and other features in the Publisher 2010
environment. You can view multi-page publications either as a single page or as a two-page spread. To switch back and forth between these views, click the icons on the Views toolbar. To view more or less details in your publication, you can zoom in or out by clicking and dragging the slider. Guides are
horizontal and vertical lines that appear in your publication while you edit it. They help you align text, pictures, and other objects on the page. The rulers are located at the top and left of the publication. They make it easy to precisely adjust and move items, such as images and blocks of text. The ribbon
contains all the commands you'll need to perform common tasks. It has several tabs, each with multiple groups of commands. Additional tool tabs will appear when you format certain items, such as pictures, or text boxes. The Quick Access toolbar lets you access common commands, regardless of the
tab you use on the Ribbon. By default, displays the Save, Undo, and Redo commands. The Page Navigation pane lets you view and work with pages in your publication. You can add, delete, rearrange, and duplicate pages in the Page Navigation pane. You can also organize pages in Sections. Working
with the Publisher 2010 environment One of the first things you might notice when you open Publisher is that the rulers and instructions used to align document components are slightly different from those in other Office programs. Other features of the Publisher environment may seem more familiar. For
example, you'll recognize the Ribbon, where you can find the commands you need to complete common tasks in Publisher. The Ribbon contains several tabs, each with multiple groups of commands. Some tabs, such as Text Box Tools or Picture Tools, can only appear when you work with certain items,
such as text boxes or pictures. Publisher Ribbon Viewer Tools provide a group of visualization tools to help you control the appearance of text, pictures, and objects on the page. These viewing tools are for editing only. They can be turned on and off and will not appear in the Printed. To access and
choose the viewing tools, select the View tab, and then find the Show group. Click the check boxes of the different view options to turn them on and off. Publishing Viewing Tools Publishing View Tools include: RulersYou can use the rulers on the left and top of your publication to help you align text,
pictures, and more and get a clearer idea of exactly where these objects will appear on the printed page. When you select an object from your publication, a white space appears on the rulers to show the object's location. Subsoil Rulers Baselines are evenly spaced horizontal lines that you can use to
align text. You'll learn about automatically aligning text to baselines in the Work with Text lesson. BaselinesBoard limits are dark blue dotted borders that appear around objects. Viewing object boundaries can be useful when aligning objects or wrapping text. Object LimitsGuide Guides are thin lines that
help you align different objects. There are two types of guides: edge guides, which are blue lines that mark the edges or edges of the printable area on each page of the publication. Edge guides are created automatically when you set page margins. CustomIzable Guides edge guides, which are green
lines that you can add anywhere in your publication. Customizable green guides To add green guides: Click the horizontal or vertical ruler. Create a vertical guideDrag the mouse to the publication, and release to add the guide to the desired location. Dragging the guide to the desired locationYour law will
be placed. You can move it at any time by clicking and dragging it. The guide added Backstage View In Publisher 2010, the options for saving, printing, and creating publications are in Backstage view. It's similar to the Office Button Menu in Publisher 2007 or the File Menu in earlier versions of Publisher.



However, unlike these menus, it's a full page view, making it easier to work with. To access the Backstage view, click the File tab. Click the File tab to go to the Backstage Review review view below to learn about the different things you can do in The Backstage view. Here, you can change different
Publisher options. For example, you can adjust spelling and grammar check settings, autorecovery settings, and language preferences. From the Help pane, you can go to Microsoft Office Help or check for software updates. Save &amp; Send offers options that allow you to save your publication as a
PDF, image, or webpage or send it as an email. You can also pack your publication so that you can send it and any of the fonts, graphics, or other custom files to another computer. From the Print pane, you can change your print settings and print your publication. You can also see preview of how the
publication will look on the page. From here, you can create a new, blank publication, or choose from a wide selection of templates. The information contains information about the current publication. You can also edit business information if you want Publisher to automatically add information such as
your company's address and phone number to publications you create from templates. In addition, you can use to find any issues that may negatively affect your printed publication. If you plan to print your publication professionally, you can also change your commercial print settings. The Recent pane
allows you to conveniently access recently edited publications and file folders. Familiar tasks, such as Save, Save As, Open, and Close, are now found in Backstage view. Challenge! Open Publisher 2010 on your computer. A new blank publication will be created. (You'll need to exit Backstage view to
view it.) Click all the tabs and see the Ribbon options change. Try turning various viewing tools on and off. Add a green guide. Return to the Backstage view to see the information about the publication. Close Publisher without saving your publication. /en/publisher2010/producing-a-publication/content/
/en/publisher2010/producing-a-publication/content/
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